
The NorXfer (Transfer) program 
pro vides modules for the transfer 
of meas ure ments made with the 
Nor110, -116, -118, and the Nor-
121. In addition conversion of fi les 
imported from Nor840 (e.g. via 
fl op py disk) may take place. The 
data trans ferred can be con vert ed 
to fi t spreadsheets and thus easily 
be come subject to post processing, 
reportmaking and pres en ta tion. 
The program is tight ly in te grat ed 
with the NorPro fi le and NorRe-
view postprocessing soft ware. 

The program requires Pentium 
type PCs with Microsoft Win dows  
NT4,  2000 or XP. 

To be able to convert data to MS-
Excel format, MS-Excel must be 
installed in the PC.
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trademarks of their respective com pa nies.
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for the use of – nor for the consequential damages of the use 
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Further -more Norsonic AS assumes no re spon si bil i ty for any 
infringement of the in tel lec tu al property rights of third parties, 
wherever ap pli ca ble, which would result from such use.

Norsonic AS reserves the right to amend any of the information 
given in this manual in order to take ac count of new 
developments.

If you wish to communicate with us, please feel wel come. 
Our address is:

Norsonic AS, P.O. Box 24, N-3421 Lierskogen, Nor way. 
Tel: +47 3285 8900, Fax: +47 3285 2208 
e-mail: info@norsonic.com
www.norsonic.com

Copyright © Norsonic AS 1998–2004

All rights reserved
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A few defi nitions:

.nbf Norsonic binary fi le format (used by the Nor110/116/118)

.npf Norsonic project fi le format (used by the Nor121)

.par ASCII measurement setup information fi le (used by the Nor110 /116/118)

.prn ASCII measurement data fi le (used by the Nor110/116)

.sdf binary fi le format used by the Nor840

.xls MS-Excel format
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Installing NorXfer

Version requirements:

NorXfer version 4.0 requires:

Nor110 version 3.20 and higher
Nor116 version 2.20 and higher
Nor118 version 1.1 and higher
Nor121 soft ware version 2.3 and high er. 

Nor121: If the in stru ment software is old er, 
the com mu ni ca tion soft ware in the in stru -
ment may be upgraded by the user. 

The NorXfer (Transfer) software util-
 ity has been designed to provide easy 

trans fer of measured data from Nor son ic 
in stru ments to a PC running Windows 
95/98, NT 4.0, 2000 or XP.

Installing NorXfer
NorXfer is a program designed to take care 
of the transfer of measurement data from 
your Norsonic sound measuring instru-
ment to your PC. 

General Considerations
We recommend that you exit all pro grams 
before you start the installation. This frees 
up memory for in stal la tion and prevents 
possible confl icts be tween the NorXfer 
installer and other programs. 

Installing the Program
Insert the CD-ROM. The Autoplay fea ture 
will start the installation program. Just fol-
 low the in struc tions appearing. If it does 
not, do as follows: In Win dows 2000/XP 
right-click on the drive-let ter (e.g. D:\). A 
con text-sen si tive menu will appear con-
 tain ing Autoplay and a ReadMe fi le which 
you may want to read. In Win dows NT go 
to the CD-ROM drive and dou ble-click 
norsonic.exe on the root. 

A web-page like interface will now ap-
pear. Select "NorXfer 4.0" by clicking on 
it. If this installation is an update of an 
existing version of NorXfer, the old ver-
sion must be removed before you proceed 
with the installation itself. Select "Remove 
all installed components" and click Next.  

Observe that fi les stored in My measure-
ments are left unaffected by this. Once the 
old version has been removed completely, 
select "NorXfer 4.0" again and the instal-
lation process will install the new version 
on your hard disk. Just follow the instruc-
tions appearing.

Installing from a 
downloaded zip-fi le
If you have downloaded NorXfer from our 
web site, you must unpack the fi les before 
installation.

You will need a zip program – such as 
PKUNZIP or WINZIP to do this.

Do as follows:

• Copy the zip-fi le to a temporary fold-
 er. 

• Unpack the fi les using pkunzip or win-
zip

• Use the Windows Explorer to lo cate the 
fi le Setup.exe in the temporary folder. 
Double-click this fi le and follow the 
instructions.
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Running NorXfer

When the program is started a PC 
  file/folder view similar to the 

well-known Windows Ex plor er appears. 
However some features from Explorer 
are missing.

The user can select which PC drives to 
show in the directory tree. 

Press View > Options and key in a list of 
drives letters without sep a ra tors. 

Several Instruments of Type Nor110/Nor-
116/Nor118 and one Nor121 can be con-
 nect ed si mul ta ne ous ly.

Connection to Nor110, Nor116 or Nor118 
is pos si ble at serial ports COM1 .. COM4. 

In order to browse through the con tents of 
the Nor121, the instrument must be con-
 nect ed to a parallel port LPT1 or LPT2 or 
a serial port. Due to speed con sid er a tions 
we rec om mend parallel con nec tion. 

With Windows NT NorXfer will need to 
in stall a device driver (FastLynx.sys) in or-
 der to connect to LPT1 or LPT2. You must 
have ad min is tra tor priv i leg es to do this 
– see sep a rate box below for details.

With Nor121 you may also save meas ure -
ments on an external drive (ATA Card or 
Jaz Drive). 

When the measurements have been saved 
and the instrument is switched off, you 

may con nect the ex ter nal drive to your 
Laptop PC. 

Select “local” connection to access data on 
this medium.

Refresh Screen
Select a folder and click the refresh icon 
to update the dis play of the current folder 
in the tree when the contents have been 
al tered by other pro grams than NorXfer.

Open existing text fi le

Display directory tree 
(similar to File>New)

Connect instrument
(see also text for 

details)

Blue colour indicates 
that these folders are 
inside the instrument

Submenu appearing 
when Connect 

instrument has been 
activated

Refresh display icon

Caution!
Never disconnect an 
instrument physically from 
the PC without informing 
NorXfer (by pressing the 
disconnect button or by 
closing NorXfer).

Delete fi les per ma nent ly 
(they are not sent to the 
recycle bin!) Nor121 only!

The instrument must 
be in “Transfer Mode” 
before starting a parallel 
connection. Press MEMORY 
and then select NOR-XFER 
in the instrument. Wait 
until the text “Transfer” 
is shown in the Nor121 
display before selecting 
“Connect Instrument” in 
the NorXfer program. This 
won’t be needed for serial 
connection.
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Connect Instrument
Be sure to connect the instrument to the 
PC through an appropriate cable. Click 
on the Connect button (  ) to select an 
instrument and to start the connection. 
The in stru ment ap pears as if it were a 
de tach a ble drive. The in stru ment fold ers 
are blue to in di cate that the con tents are 
still in side the in stru ment.

When quitting the program your latest 
se lec tions will be preserved for use the 
next time you start the program.

Running the program
Files and complete folders can be trans-
 ferred us ing the clip-board (copy and 
paste) or by drag and drop in the same 
way as with Win dows Ex plor er.

Transferring from 110/116/
118
1. Connect the cable and switch on the 

instrument.

2. Click the Connect button (  ).

3. In the dialogue box appearing, select 
instrument type and corresponding 
connection port.

4. Select the Serial port setup tab and 
set the baud rate. Use 9 600 baud for 
Nor110 and Nor116; 115 200 baud for 
Nor118 and Nor121. Remember to set 
the instrument to the same baud rate!

5. Expand the folder-tree of the in stru ment 
if needed. Select the fi le to be trans ferred 

by clicking on its name. Se lect more than 
one fi le by pressing Ctrl while click ing 
on the fi le name. 

   To select several consecutive fi les se lect 
the fi rst fi le and  move the mouse to the 
last fi le in question, press Shift and click 
on this last fi le. 

   The two methods may be com bined to 
the extent you want.

   Alternatively, you may use SHFT Arrow 
up or CTRL Arrow down.

   Single fi les can be deselected by press ing 
Ctrl while clicking on the fi le us ing the 
left mouse button.

6. Press Ctrl C to copy the selected fi les. 
Se lect a destination folder and press 
Ctrl V to paste the fi les or select Edit > 
Copy, go to the destination folder and 
select Edit > Paste.

   Alternatively, you may use the mouse 
and simply drag the selected fi les over 
to the destination directory. 

Allow some time for the fi le transfer to 
take place. 

Naming Conventions
Files from the Nor110/116/118 will be giv en 
a fi le name composed from the instrument 
di rec to ry name followed by an un der score 
(ie the _ character) and the four-digit meas-
 ure ment number.

The extension NBF stands for Norsonic 
Bi na ry Format.

Example: Assume that we transfer the 
file 999 of the directory 021104 in the 
Nor116. This fi le will appear in the PC as: 
021104_0999.NBF.

Transferring from Nor121
Transferring files from the Nor121 is 

very similar to the transfer of fi les from 
the Nor110/116/118. However, the file 
struc ture is somewhat different, since a 
Nor121 meas ure ment in fact consists of 
sev er al (sub)measurements like profile, 
re ports 1~5, event etc. 

Therefore each measurement in the 
Nor121 consists of a folder containing 
sev er al fi les. In the NorXfer Tree view, the 
measurements are organised in three lev els 
of folders. 

The fi rst level is the storage medium in the 
instrument, the second lev el is the meas-
 ure ment group,while the third lev el is the 
meas ure ment title. 

Each complete meas ure ment is stored in 
the third level and is given the name Group_
Title_Index_date-and-time-of-day-of-storage 
once they have been transferred to the PC. 
Since each measurement consist of several 
reports etc. these are kept together in a 
measurement folder which appears yellow 
(like folders do in Windows explorer), but 
with the text 121 written on it.

By giving the measurement folder a name 
containing the group, title, index and 
date/time, ambiguity is avoided (you won't 
meet two completely unrelated versions of 
measurement No. 3).

If you connect the Nor121 to a serial port 
(Com 1…4) of your PC, you can also select 
and transfer parts of a meas ure ment, such 
as a single report to save trans fer time. The 
other reports, events or re cord ings can be 
selected and transferred individually at a 
later time, if needed. 

Just click on the yellow foilder marked 121 
and the individual fi les are revealed.

Example: Assume we have a Group 
named Anton, a Title Dvorak and an Index 2. 
Upon transfer to the PC, NorXfer will  cre-
ate a folder named Anton_Dvorak_2_[start 
time], in which [start time] is the date and 
time when the measurement was started. 

Using NorXfer with Windows NT/2000/XP

You’ll need Administrator privileges to in-
 stall NorXfer on a system running Win dows 
NT/2000/XP.
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In this fold er you will fi nd all the meas-
 ure ments (event, pro fi le, re port No. n etc.) 
made and stored as Index 2 ti tled Dvorak 
under the group Anton.

To transfer fi les, use the methods of se-
 lect ing, copying and pasting or drag and 
drop as described under Transferring Files 
from Nor-110/116/118 above. Use 19200 
baud.

Memory card
Data measured with Nor121 may be stored 
on an external memory card. If your PC has 
a suitable slot or card reader, the stored 
information may be transferred to your 
PC directly from the memory card by the 
use of NorXfer. 

To access these fi les, plug the card to your 
PC. Start NorXfer the usual way, and ini-
tiate a connection. Then select <121> for 
instrument and <local> for connection, 
and hit <enter>. A Nor121 icon followed 
by the text Nor121.local will appear. The 
internal memory structure of the device is 
shown as usual, and operations like fi le 
download and fi le conversion are exactly 
as usual.

Converting Files
Files from Nor110/116/118/121 may be 
con vert ed to text format or MS Excel 
work books: A conversion to MS Excel 
format requires the presence of MS Excel 
in your PC. (Excel 2000 or newer).

Converting 110/116/118Files
Select the fi les you want to convert to 
Ex cel workbook format using the familiar 
Win dows methods described above. Once 
se lect ed click the right mouse button and 
se lect from the context sensitive  menu 

ap pear ing. The fi les can then be studied 
and processed in Microsoft Excel.

Nor116/118 Overview Function
A convenient feature of NorXfer is the 
over view function. This function creates 
a single fi le out of several measurements 
already transferred to the PC. The overview 
fi le will contain the global data of the se-
lected measurements.

To utilise this feature make sure the meas-
urement fi les, for which you're going to 
create overviews reside in the same folder 
on your PC, i.e. on the same level in the 
fi le/folder hierarchy. 

Select a group of *.nbf fi les and click the 
right mouse but ton. Se lect the option 
Overview text or Overview Excel from the 
context sen si tive menu.

Converted overview files are stored in 
the same folder as the fi les it was created 
from.

Nor121 Overview Function
You may convert the global data of several 
Nor121 measurements already transferred 
to your PC, into a single text fi le or Excel 
fi le.

Make sure the measurements, for which 
you're going to create overviews reside in 
the same folder on your PC, i.e. on the 
same level in the fi le/folder hierarchy. This 
will typically be the case when you transfer 
a set of measurements stored in the Nor121 
under the same Group and/or Title.

Navigate down to the measurement folder 
level (you're there when you see the yel-
low folders with 121 written on them) and 
select the number of 121 folders required. 
Right-click the mouse and select the op-
tion Overview text or Overview Excel from 
the context sen si tive menu.

Example showing folders with 121 written on them 
and the contents of one of these folders
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Converted overview files are stored in 
the same folder as the fi les it was created 
from.

Converting Nor121 Files
This utility can also be used to convert 
multispectrum measurements from the 
Nor840.

When using the Nor121: 

1. In Nor-Xfer locate the meas ure ment 
di rec to ry named Group_Title_Index in 
the directory tree.

   In the fi le list in the right pane a fi le 
named Nor-121.NPF appears. Never 
delete this fi le! This is the header fi le 
for all the hidden data fi les in the meas-
 ure ment directory. Below Nor-121.NPF 
sev er al reports are listed.

2. Select one or more reports. Right-click 
to get a con text menu and choose the 
for mat to convert to.

   Then wait!  This may take some time.

When using fi les from Nor840:

1. Locate the measurement di rec to ry in 
the tree. In the fi le list in the right pane 
Nor840 fi les have extension .sdf

2. Select a fi le or a group of fi les and right-
click to produce the context menu and 
choose the output format

3. Sit back and wait. This is likely to take 
some time.

The conversion process may take con-
 sid er a ble time. Your PC may seem to be 
hanged up whilst converting.

When the conversion is completed you will 
see one or several text fi les or  spreadsheet 
work books. They are al ready saved in the 
meas ure ment directory in Microsoft Ex cel 
format. 

If you save the workbooks under a new set 
of names you will be able to avoid that the 
workbooks are overwritten each time you 
convert the measurement fi les.

Open Existing Text 
Documents
You may open fi les of the types *.txt, *.prn, 
*.par and *.xls by double clicking on the 
fi le icon.

Deleting Files
The program allows you to delete fi les 
transferred to PC only. To delete fi les in 
the instrument itself, use the instrument 
keyboard. See the documentation accom-
panying your instrument.

Selected fi les of the types *.txt, *.prn, *.par, 
*.xls, *.sdf and *.nbf or entire di rec to ry trees 
are deleted permanently by click ing on the 
Delete icon or by press ing the DEL  key.  
The fi les will be sent to the re cy cle bin. 

Optional extensions
There are optional extensions available for 
this program: These are:

•  Instrument Nor110

•  Instrument Nor116

•  Instrument Nor118

•  Instrument Nor121

Contact your local representative or 
www.norsonic.com for details on the 
avail a bil i ty.

Instrument Version 
Compatibility
Because Nor-Xfer is using advanced 
fea tures of the instruments, it requires 

the in stru ments to be up to date. The 
min i mal requirements for Nor-Xfer Ver-
sion4.0  are:

Nor110:  Version 3.20

Nor116:  Version 2.20

Nor118:  Version 1.1

Nor121:  Version 2.3 (parallel connection)

Nor121:  Version 3.0 (serial connection)

More on this in NorXfer\Compatib.txt on 
the CD. 

If your instruments do not fi t these re-
 quire ments, please ask your distributor 
to up grade the instrument to a newer 
ver sion. 

The Nor121 has the pos si bil i ty of a par tial 
upgrade, which replaces only the com-
 mu ni ca tion portion of the software in 
the in stru ment. Run the installation CD 
and fol low the instructions in the sections 
NorXfer and Nor-121 Slave Up grade.    
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Building Acoustics using Nor121 and NorXfer

be set. If the parallel port is used, the 
instrument has to be set in transfer 
mode. The transfer mode may be se-
lected by pressing Memory , move the 
cursor to the NorXfer fi eld and press 
Enter. Wait until “Transfer mode...” is 
displayed,

2. Start the NorXfer program in the PC.

3. Click on the communication symbol. 
A symbol for the instrument Nor121 
will be shown in the folder “My In-
strument”. Click on the + symbol to 
expand the diagram. The main blocks 
of the memory system in the instru-
ment will be shown. Click on the hdd 
–symbol if the values are stored on the 
hard disk drive. Expand the fi le struc-
ture until the wanted measurement 
fi le is displayed. Drag and drop the 
measurement fi le in the instrument 
to the folder “My measurements” (or 
other displayed folder)

4. Open the recently stored  measure-
ment folder in “My Measurement” 
marked with the 121 –symbol and the 
measurement fi le number. In addition 
to three apparently empty folders, 
three fi les marked with the instrument 
symbol are displayed:

     - Nor-121.npf
 - Sending room
 - Receiving room

   The latter two contain information for 
the sending and receiving room, re-
spectively. The “nor-121.nfp” contains 
all the information.

5. Point on “nor-121.npf”  and right-click 
the mouse. Select “Convert to Excel” or 

“Convert to text” as appropriate. The 

converted fi les will be placed in the 
same folder as the “nor-121.npf” fi le.

6. If the “nor-121.npf” fi le is converted 
to text, up to seven different text fi les 
will be generated:
 - BA_Setup.txt
 - BA_Sending room.txt
 - BA_Receiving room.txt
 - BA_BGN.txt
 - BA_Reverbation.txt
 - BA_Correction.txt
 - BA_Rating.txt

   The delimiter may be selected in 
“View – Options” setup.  

7. If the “nor-121.npf” fi le is converted to 
Excel, a workbook with up to seven 
different worksheets will be gener-
ated: 
 - Setup
 - Sending room
 - Receiving room
 - BGN
 - Reverbation
 - Correction
 - Rating

8. The measurement values are accompa-
nied with text to identify the different 
values. 

The program NorXfer allows data meas-
ured in the building acoustic mode to be 
transferred to a PC. The results may be 
converted to a text fi le, or to MS Excel 
work-book. Please refer to the NorXfer 
manual for requirements to the PC, for 
the appropriate version of MS Windows 
programs, and to the procedure for in-
stallation. This description only describes 
items that are specifi c for the building 
acoustic mode of Nor121.

A building acoustic measurement consists 
typically of averaged values for each of 
the measurement positions as source and 
receiving room. By manual operation of 
the Nor121, only the averaged value is 
displayed. However, when a measure-
ment is stored, the measurement result 
for each individual measurement is stored 
and the averaged value and the standard 
deviation are computed. NorXfer is an ef-
fective mean for transferring these data 
to a PC for further calculation in order to 
make the fi nal report.

Note that Norsonic also supply PC pro-
grams for controlling the measurement 
and for making the fi nal report based on 
a number of international and national 
standards. Please contact your local Nor-
sonic supplier for further information on 
the programs  NorSic and CtrlSic.

After a building acoustic measurement is 
fi nished and the result is stored, the result 
may be transferred to the PC in the fol-
lowing way:

1. Select serial port or parallel port for the 
communication. Make the cable con-
nection to the appropriate PC-port. 
Switch on the instrument Nor121. If 
serial port is used, the baud-rate has to 
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 Introduction
The transfer of data from Nor121 when 
using the parallel port is implemented 
by the use of a program module named 
FastLynx. Here follows some tips from 
the manufacturer of the module.

Access denied message on 
LPT or COM port
When listening as server or connecting as 
client on a COM or LPT port, if you see 
an “Access denied” message, this usually 
means that another program or device 
driver has the indicated port open, which 
prevents FastLynx from opening and us-
ing it.  The fi rst thing to try is to close any 
running programs that might be using the 
port.  If you had previously run a program 
in a DOS session that accessed the port, 
the DOS session may still have the port 
open even though the DOS program that 
originally used the port has exited.  Close 
the DOS session to free up the port.  If 
you have Windows Direct Cable Connec-
tion (DCC) confi gured to use the port, you 
will probably need to disable DCC before 
FastLynx can use the port.  After doing the 
above, you need to click the appropriate 
LPT or COM port check box “off” and then 
“on” again to get FastLynx to try to open 
the port again.

For LPT ports, this problem can occur if you 
have a printer driver installed.  Some print-
er drivers have an option to continuously 
poll the printer port to check on printer 
status.  If your driver has such an option, 
you may be able to free up the LPT port by 
selecting the printer driver option to NOT 
poll for status.  Other printer drivers have 
an option to allow or disable printing from 
DOS programs.  If you don’t need to print 

from DOS, disabling DOS mode printing 
will sometimes free up the LPT port.  The 
Lexmark 2050 series is an example of a 
driver that has this option.  When using 
this driver, run the “Lexmark 2050 Series 
Ctrl Prog” and then select the Options tab. 
Then check the option at the bottom that 
says “Disable CJ2050 Series DOS Printing”.  
Other printer drivers may not have options 
such as these that will allow FastLynx to 
use the LPT port while the driver is loaded.  
In that case, the only recourse is to disable 
or uninstall the printer driver before using 
FastLynx on the LPT port.

”FastLynx NT device driver 
is not installed” message
If you are trying parallel transfer on 
Windows XP, 2000, or NT 4, and see the 
message that the NT device driver is not 
installed, perform the following steps to 
load it:·
•  Log on as a user with Administrative 

privilege ·
•  Start FastLynx ·
•  Select the Setup/ReadMe option from the 

FastLynx File menu 
•  Check the box related to the NT driver in 

the dialog box ·
•  Press the OK button or hit the Enter key 

Parallel connection succeeds 
but then drops later
If you succeed in getting a parallel con-
nection, but the connection drops later, try 
the following:
•  Insure the parallel cable is screwed in 

snugly 
•  Plug any laptops into a wall socket instead 

of running on battery power 

•  Close any other active programs before 
making the connection 

•  If you have previously used Windows Direct 
Cable Connection (DCC), please insure that 
it is not listening on the LPT port!  Breaking 
the connection does NOT stop DCC from 
listening on the port. 

•  Change the BIOS LPT port setting from ECP 
or EPP to SPP or Standard 

If the connection is consistently reliable for 
a period of time when you fi rst start using 
FastLynx, you may be having a problem 
with power management features or a 
screen saver.  Try disabling power manage-
ment for the CPU, hard disk, and moni-
tor, and disabling the screen saver.Some 
printer drivers regularly “poll” the printer 
port looking for status information.  If your 
printer driver is trying to use the same LPT 
port as FastLynx, this polling can disrupt 
the ability of FastLynx to maintain a reliable 
connection.  Disable printer status polling 
if your driver has this option.  Some drivers 
don’t have a way of turning this off.  In that 
case, try disabling or uninstalling the print-
er driver if practical.The last thing to try is 
lowering the parallel port Maximum Speed 
value.  To do this, press the “Specify Remote 
Connection Parameters” button and then 
select lower Maximum Speed values, one 
step at a time (the list is sorted with higher 
speeds at the top).  This only needs to be 
done on one of the two computers.  If none 
of the above helps, you may have a cable 
problem or a hardware problem in one of 
the parallel ports.  We suggest using serial 
transfer as an alternate method.

Serial connection succeeds 
but then drops later
If the connection is consistently reliable for 
a period of time when you fi rst start using 

Transfer troubleshooting when using parallel port on Nor121
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FastLynx, you may be having a problem 
with power management features or a 
screen saver.  Try disabling power manage-
ment for the CPU, hard disk, and monitor, 
and disabling the screen saver.

Another thing to try is to disable acceler-
ated mode.  To do this, press the “Specify 
Remote Connection Parameters” button in 
FastLynx and then uncheck the serial ac-
celerated mode box.  If this doesn’t help, try 
lowering the Maximum Baud Rate param-
eter one step at time.  The last thing to try 
is lowering the Maximum Block Size value.  
These steps only need to be performed on 
one of the two computers.

My application doesn’t work 
after I transfer it to another 
computer
In the old days, you could often suc-
cessfully transfer a DOS application and 
associated data fi les to another computer 
using FastLynx. With newer Windows ap-
plications, this often does not work. Many 
applications rely on installation and setup 
programs to write settings to the Win-
dows registry. Registry settings are not 
transferred by FastLynx, which can cause 
problems if you are trying to transfer an 
application. Another problem is that many 
applications now install shared DLLs in 
directories other than the main application 
directory. Due to these and other problems, 
it is often not possible to transfer a Win-
dows application and associated data fi les 
solely by using FastLynx. The recommend-
ed procedure when you want to transfer an 
application is to re-install the application 
on the target computer from the original 
media. Then transfer the application’s data 
fi les using FastLynx.

File names with certain 
extended characters won’t 
transfer
On Windows 95 and 98, you may have 
trouble transferring rare fi le names created 
by old DOS applications that have certain 
extended characters in them.  Windows 95/
98 does fi le I/O using the ANSI character 
set, but DOS uses the OEM character set.  
There are some extended characters in the 
OEM set that do not exist in the ANSI set.  
Such fi les cannot be created by typical Win-
dows programs, but they can be created by 
certain DOS applications.  The symptom of 
this problem is that you highlight a fi le to 
transfer it, and then FastLynx says it can’t 
fi nd the fi le.  The Windows 95/98 Explorer 
has the same problem.  You can usually 
transfer such fi les by running the DOS 
slave on the system with the problem fi le.  
Since the slave is a DOS program, it can 
read the fi le name with the OEM charac-
ters.  FastLynx will change the name of the 
fi le to a Windows compatible name during 
the transfer, but at least you can transfer 
the fi le.  This problem does not occur us-
ing the NT version of FastLynx because the 
NT version processes fi le names using the 
Unicode character set - which includes all 
characters in the OEM and ANSI charac-
ters sets (and many others).


